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Version Information

Release 2018.3.0 contains enhancements to MYOB Greentree Desktop and MYOB Greentree Browser. 

In Greentree Desktop, we've integrated Qlik Sense with Workflow Desks for better reporting, improved team security, made several
performance improvements, and made changes to the Interface Maintenance form. 

In Greentree Browser, we've added new columns to the Timesheet Review form to make it easier for reviewers to check timesheets. 

This release also includes bug fixes for both Greentree Desktop and Greentree Browser.
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eDocs

eDocs - Drill Down on eDocs Transactions

You can now drill down from eDocs transactions ? like AP Statements, AP Invoices, and AP Credit Notes ? to a preview in
Report Writer. The Report Writer preview lists all expense claims and expense reports associated with the transactions.

Reference:

Type: Enhancement

Release version: 2018.3.0

eDocs - Right Click to Approve in the eDoc Header

You can now approve or reject invoices and credit notes by right clicking in the eDoc Header panel on an eDocs Workflow
desktop. You can approve or reject individual invoices or credit notes, or press Shift and click to select multiple items to
approve or reject. 

When you right click, a menu that includes these options display: 

Approve - You can approve the selected invoices or credit notes. You can add an explanation to the approval. 

Approve - No Narration - Approves the selected invoices or credit notes, but you cannot add an explanation. 

Reject - You can reject the selected invoices or credit notes. You can add an explanation to the rejection.  

Reference:

Type: Enhancement

Release version: 2018.3.0

eDocs - New Column in the Transactions Table
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We've added the PO Ref column to the Transactions table on the Payments sub tab of the AP Supplier Payment form. This
column shows the number that identifies a purchase order receipt linked to a purchase order. 

You can drill down from this column to view the details of a linked purchase order receipt. 

Reference:

Type: Enhancement

Release version: 2018.3.0

eDocs - Issues Fixed in 2018.30

We've fixed these issues in eDocs: 

When adding an item on the Job tab of the eDocs AP Invoice form, ensure that the Tax value agrees with the value of
the scraped GST Total tax before creating the invoice. 

When you add a line to the Main tab on an eDocs Expense Claim form, that line no longer displays the image from the
preceding line (if there is one). 

eDoc AP invoices now default a quantity when you enter an amount for a line and then click the Select checkbox in
the Amount field. 

On the Expense Item Maintenance form, expense receipts and credit cards now only show the general ledger
accounts for the company that the user is logged into rather than for all companies the user has access to. 

On the AP Statement form, the error message Matched Value does not equal Entered Value no longer displays
when: 

A matched value agrees with the total of outstanding transactions, and 

You click Yes on the message Total of all outstanding transactions matches the statement total. 

On an AP invoice, entering a value in the Amount field before clicking the Select checkbox does not set the entries in
the Quantity, Price, and Amount fields in the table to 0. 

The error message Serial/Lot number was not found for the total line item quantity no longer displays when you
generate an eDoc AP invoice for a serial/lot item that's receipted using Advanced Invoicing. 
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The correct number of licenses in use now displays beside the Scraping Supplier Invoices (H/L) and Scraping
Supplier Invoices (H) items on the Help > About form. 

Receipt lines that have been coded no longer randomly display as uncoded on the Expense Claims form. 

We've resolved the Error 4 that displayed when you tried to view matched lines on AP invoices. 

Requisition types no longer load slowly when you have a large number of items. 

eDoc expense claim lines are no longer duplicated when the first line is left uncoded and an Approvals and Alerts rule
runs to alert the user to code all lines. 

Loading requisition types into the Requisition Types table is now faster.

Reference:

Type: Bug

Release version: 2018.3.0

Module

Greentree Desktop - User Interface Improvements 

We've made the fonts on the forms in Greentree Desktop easier to read. The text of labels and on buttons and tabs is bolder
and clearer. 

Here's an older form: 

 

Here's a form with the new fonts: 
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We've also made these changes to the user interface: 

Required fields that are missing information and fields that contain invalid data are now highlighted in yellow, not red: 

 

Read-only items are now a lighter blue. 

 

We've put the Default colours settings back on the General tab of the File > Preferences form. You can now change
the default colours for displaying read-only and error information in Greentree Desktop. 
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Reference:

Type: Enhancement

Release version: 2018.3.0

System Setup

Greentree Desktop - Changes to Team Security Attributes

We've improved the way in which Greentree handles the security attributes of teams, and how the attributes apply to users
who are members of those teams. 

Users must now have a primary team set on the User Maintenance form under System > System Setup. The primary team
contains a user's main security attribute settings. 
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If you don't set a primary team, an error message displays when you click Save on the User Maintenance form. 

Note: If the user is assigned to only one team, Greentree selects the Primary option for that team when you click Save. 

When you apply the 2018.3.0 pack to an earlier release of Greentree Desktop: 

If the user is assigned to multiple teams, the last team in the list is set as the primary. 

For a user assigned to only one team, Greentree sets that team as the primary. 

Note: When updating a user's primary team, Greentree only looks at a user's preferences in the current company for these
modules: Purchase Orders, Sales Orders, Inventory, Job Costing, and Bill of Materials. 

Adding or Removing Access to a Module or Function 

Many of the access permissions granted to members of teams in Greentree Desktop work on the least restrictive principle. A
user inherits the highest level of permissions from the team that they're assigned to. 

If access to a module or function is: 

 

Removed from a team, the user only loses that access if the other teams they're assigned to do not have access to
that module or function. 

Granted to a team, the user gets access to that module or function regardless of the security applied to their other
teams. 

Note: You can read more about security attributes and how they're applied in the Greentree Desktop online help.

 

Reference:

Type: Enhancement

Release version: 2018.3.0

Greentree Desktop - Changes to Interface Maintenance Form

We've changed the Interface Maintenance form to make it easier to edit the interface formats used to import and export bank
data. 

Access the form by selecting either System > System Setup > Interface Maintenance or Workflow > System > Data
Import Manager > Interface Maintenance. 
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On the Interface Selection form, choose the interface you want to modify, and then click Edit. 

 

To: 

Change an item in the Value column, either double click the item or select it and click the Select button. 

The System Fields form displays. Select a field and then click OK. 

Change the format of a line, either double click in the Format column or click in the column and then click
the Format button. 
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The Field Formats form displays. Select a new format for the line, and then click OK. 

Move a field, select the field and then click the Move Up or Move Down buttons. 

Delete a field in the interface file, select the field and then click the Delete field button.

Reference:

Type: Enhancement

Release version: 2018.3.0

Utilities

Greentree Desktop - Performance Improvements

We've improved the performance of Greentree Desktop in these areas: 

Progress Bars 

Service Planner 

Progress Bars 

We've changed the way progress bars work in Greentree Desktop. The progress bars no longer refresh as frequently. On
slower connections, operations take less to time to perform while giving you enough time to cancel an operation if needed. 

 

On most forms, the progress bar now appears at the top of the form (above the form's toolbar, if there is one), rather than as a
separate dialog box that hovers over the form. 
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Service Planner 

We've increased the speed at which the Service Planner loads pages ? even pages containing large amounts of data. This
change has removed network latency as a performance issue for the Service Planner. 

In MYOB's tests, the time to load Service Planner pages went from 17.5 seconds to four seconds, and 205 seconds to 3.4
seconds. Your results may vary, but you should notice improved performance.

Reference:

Type: Enhancement

Release version: 2018.3.0

Greentree Desktop - Enhanced Backup Options on Task Scheduler Form

We've changed one of the options for the Backup database online task on the Task Scheduler form. The Backup bin
directory (recommended) option is now Back up binaries and web resources. 
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This option backs up the Greentree system directory and these folders: 

\bin 

\bin64

\webroot 

Note: If you set the \ webroot  folder as a directory to include in the backup by clicking the Select additional directories button,
Greentree does not back up that folder twice.

 

Reference:

Type: Enhancement

Release version: 2018.3.0

Greentree Desktop - Enhanced Logging for Performance Issues

Note: You should only use this feature when instructed to do so by MYOB's developers or support personnel.

When a user is encountering performance issues  with Greentree, administrators can now turn on performance monitoring for
that user for a specific period of time. Greentree creates a log file containing performance information, which they can send to
their Greentree partner or MYOB support for analysis.

You activate monitoring in the Performance monitoring section of the User Maintenance form.
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Select the Enable performance logging option, and enter the number of hours over which you want to collect information. At
the end of that period, Greentree save a log file to the \log folder on the Greentree server.

The information the file contains includes:

Date and time

Transaction ID

Elapsed time

Error messages (if any)

CPU usage

The number of create, update, delete, commit, and event actions

The number of messages sent by the Greentree server and Greentree Desktop

The number of bytes sent by the Greentree server and Greentree Desktop

The name of the log file has this format:

User?s name_User?s computer name_app name_date_ltl.csv
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For example: Amanda_AmandaLAPTOP_login_ 20180821_ltl.csv.

Note: If you plan to send the log file to MYOB support, you should strip out any user names in the file.

Reference:

Type: Enhancement

Release version: 2018.3.0

WebView

WebView - Upgraded dhtmlxSuite

We've upgraded dhtmlxSuite, the user interface library used with WebView, to version 5.1. This version of the library
includes a number of significant bug fixes, as well as updates to dhtmlxSuite's main components. 

Read more about the technical details of dhtmlxSuite 5.1 and see a complete list of changes in this release of the library.

Reference:

Type: Enhancement

Release version: 2018.3.0

WebView - Updated WebView VRD Files

We've updated the WebView VRD files (which define the parameters of reports saved and run in XML format). All WebView
sites upgrading to 2018.3.0 should update their VRD files to the latest version. 

Note: Failing to update the VRD files can result in erratic behaviour of WebView reports in your web browser. 

You can download the latest VRD files from this folder on the Greentree FTP site: 

Greentree/Packages/e InstallSets/Webview 

To install the VRD files, delete all content in the folder \ Webview \vrd on your server. Then, copy the new VRD files into that
folder.
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Reference:

Type: Enhancement

Release version: 2018.3.0

WebView - Issues Fixed in 2018.3.0

We've fixed these issues in WebView: 

Decimals places now round up and show as zero in percentage type columns in WebView financial reports. 

The error message Licence changes cannot be saved because licence numbers are exceeded for
suite Webview Designer no longer displays when you copy a user. 

Error 1086 no longer displays when you export a WebView report to PDF or Excel from the browser. 

When a row in a financial report is set to display only a specific tree branch, drilling down to an account now only
displays the selected branch.

Reference:

Type: Bug

Release version: 2018.3.0

Workflow

Greentree Desktop - Qlik Sense Integration

Note: You must have a license for Qlik Sense to use this feature. 

With release 2018.3.0, we've added support for Qlik Sense to Greentree Desktop. Qlik Sense is a third-party reporting and
data analysis tool that enhances Greentree's reporting capabilities. Using Qlik Sense, you can delve deeper into your data and
better analyse it. 

Learn more about Qlik Sense and what it can do. 

Initial Setup 

Before you can use Qlik Sense with Greentree Desktop, you need to do some setup: 

1. In Greentree Desktop, go to System > System Setup > General System Preferences. 
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2. On the Main tab, select the way in which you are connecting to Qlik Sense from the Qlik Sense connection
type dropdown list: 

Desktop ? Select this option is you're using Qlik Sense via the Qlik Sense Desktop. 

Active Directory ? Select this option if you're giving Qlik Sense access to your Active Directory domain to get
user credentials. 

3. In the Qlik Sense website address field, enter the URL that points to the Qlik Sense hub (which is a repository of the
Qlik Sense applications you have permissions to use). 

Note: You can learn more about the hub in the Qlik Sense online help. 

4. Save your changes. 

5. Go to File > Preferences. 

6. In the Qlik User Name field on the Main tab, enter the name of your workstation, followed by your user name ? for
example, COMPUTER123.mycorp.corp.net\jsmythe. 

This option uses your permissions to control what you can see and edit in Qlik Sense reports. 

7. Save your changes. 

Note: If you didn't select Active Directory in step 2 above, Greentree will prompt you for a user name and a password to log
into Qlik Sense. After you enter both, you connect to the Qlik Sense hub. 

Creating a Workflow Desk 

 

You interact with the information from Qlik Sense applications using a Greentree Workflow Desk. 

To create a Workflow Desk for Qlik Sense: 

1. Select Workflow > System > Organise Desks. 

The Desktop Designer opens. 
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2. In the Toolbox section, drag and drop the Qlik Sense item into the Layout section. 

3. In the Properties section, select a Qlik Sense application from the Application dropdown list. 

In Qlik Sense, applications are collections of data that you can use to visualise information in your report. 

4. In the Properties section, select a sheet within the application. 

Sheets contain different types of information ? for example, charts or tables ? that applications use to visualise data. 

5. In the Properties section, select a theme for the application. 

The theme controls the look and feel of the application in the Workflow Desk. If you don't select a theme, Greentree uses the
stock Qlik Sense theme. 

You can learn more about creating custom themes in the Qlik Sense online help. 

6. Other options that you can set in the Properties section include: 

Disable Selection - Prevents users from selecting elements on a sheet. 
Disable Interaction - Prevents users from drilling down into an item on a sheet. 
Clear Selection on Load - If a user was in another Greentree session, the Desk loads what the user was
viewing in that session when they shut down and restart Greentree, or when they refreshed the view.
Show edit in hub - Enables an icon on the toolbar of the Qlik Sense Desk. Click the icon to open sheets in
the Qlik Sense hub to edit and refine those sheets. 

7. If you want to add more sheets to the application, double click the Set up Qlik Sense option. 

The Qlik Sense Definition form opens. Use the form to add other sheets to your view and set parameters like the Desk's theme
and whether to enable or disable selections or drill down. 

 

8. Save and then open the Qlik Sense Desk. 

Here's an example of a portion of a Qlik Sense Desk: 
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You can drill down on sheets in your application using dropdown list at the top right of the Qlik Sense Desk. You can also click
the Edit in hub icon to open the sheet in the Qlik Sense hub. 

 

 

You can learn more about using Qlik Sense: 

In the Qlik Sense Online Help. 

At the Qlik Sense Knowledge Base. 

Reference:

Type: Enhancement

Release version: 2018.3.0

Accounts Payable

Greentree Desktop - Statement provided Option Available for Contractors

On the Taxable Reporting tab of the Supplier Maintenance form, the Statement provider option is now available to contractors
as well as to grant recipients. This option is for sites in Australia and indicates that a contractor or a grant recipient doesn't
need to quote an ABN number, and why. 

For more information, visit the ATO website.

Copyright © 2018 MYOB Date generated:19-10-18 15:40:49 Page 19/26

https://help.qlik.com/en-US/sense/September2018/Content/Sense_Helpsites/Home.htm
https://qliksupport.force.com/QS_CoveoSearch
https://www.ato.gov.au/forms/statement-by-a-supplier-not-quoting-an-abn/


Reference:

Type: Enhancement

Release version: 2018.3.0

Greentree Desktop - Issues Fixed in Release 2018.3.0

We've fixed these issues in Greentree Desktop: 

Accounts Payable 

When an AP payment, journal, or credit note is applied to an invoice in the current or previous and future periods, the
total outstanding value on the AP Aged Balance report now shows the correct value in the Total column. 

We've increased the length of the City field on the AP Customer Maintenance form so all of a city's name is visible. 

When you save an AP payment with an unapplied credit note, the Reference field on the Items to Pay sub tab no
longer displays UNAPP. 

When you export to XML from the Explorer, Greentree Desktop now appends the time to the end of dates. 

Selecting a supplier payment now includes the correct parent and child accounts for the payment. 

Accounts Receivable 

We've increased the length of the City field on the AR Customer Maintenance form so all of a city's name is visible. 

When you save an AR receipt with an unapplied credit note, the Reference field on the Items to Pay sub tab no
longer displays UNAPP. 

We've fixed a performance issue caused by AR statement jobs that blocked users and interfered with other running
tasks. 

You can now hotprint a receipt from the AR Receipt Entry form when that receipt is in a closed period. 

Cash Management 

We've added a Cash Management system script named Fix cancelled cheque's transaction's status. This script
ensures that an unreconciled transaction associated with a cancelled cheque has the status of Cancelled. The
cancelled transaction no longer displays on a bank statement. 

You can import CSV files without header rows into Cash Management. Transaction lines now import and process
correctly. 

CRM 
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You can print an attached barcode by clicking the icon on the Attachment form after you add the attachment
using Autoscan. 

The error Expected identifier, string or number no longer displays when you click the Web link on the Main tab of
the Organisation Maintenance form. 

Error 14074 - Text of numeric TextBox or JadeEditMask not valid no longer displays when creating or saving a quote
for a foreign customer if the exchange rate is greater than 999.99. 

When an asset has been sent for repair and is swapped for another asset, the second asset is put back in its former
location when the original asset has been repaired. 

When saving an activity or work centre by clicking the Issue Inventory button the Call or Service Request forms, the
activity code or work centre display on the Issue Service Request Inventory form. Otherwise, Greentree defaults the
activity code from the inventory item's record, or takes the work centre from the activity's default work centre. 

The barcode that Autoscan generates for location transfers now appears in a Location Transfer report when you
include the barcode. 

We've fixed a problem in eCRM where general ledger batch edit listings include timesheets for which the timesheet
batch is linked to a different company. This was caused by company settings not being properly synchronized. 

FREE 

 

When importing data using the gtCustomer function, the isOrderNumberUnique option is no longer automatically set
to false. 

When importing data using the gtJCAdjustGLLine function, if the Cost Rate is determined by a calculation whose
value is less than 0.1, the Cost is not multiplied by 100. 

HR Payroll 

We've fixed an issue where Critical Error 500 displayed when a user submitted a Single Touch Payroll
(STP) lodgement that included an employee with an employment termination payment. 

Error 1090 no longer displays when you try to open a lodgement containing errors on the Lodgements form.
The Lodgements form now opens, and you can review and fix any errors. 

We've fixed an issue where the ATO rejected an STP lodgement because the timestamp of the lodgement (computed
on a Greentree server in New Zealand) was not correctly adjusted to Australian Eastern Standard Time. 

We've fixed an issue where Critical Error 500 displayed when users tried to submit an STP lodgement to the ATO.
This problem occurred because on the Tax Config tab of the HR Employee Maintenance - Payroll form: 

Nothing was selected from the Payee tax status list, and 

The option Include in next submission to the ATO was selected. 

Greentree Desktop now displays a warning that the employee needs a payee status set before you can submit
the lodgement. 
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When updating an STP lodgement, the ATO rejected the update if it was submitted after the end of the period for the
original pay run. Greentree now uses the last day of the period as the date if the current date is after the end of the
pay period. 

To prevent Error 1090 from occurring, you can no longer delete a payment that has been lodged via STP. 

STP lodgements for companies other than the current company no longer appear in the submissions list on
the Lodgements form. This prevents a 404 submission response when you click Check Now if
the lodgement you're checking is not for the current company. 

We've fixed a problem where users could not open the STP Lodgement form. 

HR team security settings now apply to the STP lodgement preview function. Only authorised users can
preview lodgements in Microsoft Excel. 

If you select the Final for year and All paid employees options on the STP Update Lodgement form, you cannot
deselect employees in the table on the form. 

We've fixed an issue in which the Tax Summary report displayed an error and was not generated. This occurred when
the report included an employee who has: 

A salary sacrifice of 100% of their pay, and 

Allowances included in their gross pay. 

This resulted in the employee's gross pay being a negative amount, which prevented the report from being run. In this
situation, the report now displays negative gross pay if the employee has an allowance. 

You can now deselect the Create GL Journal option on the Transaction Type - Employer Costs form. 

We've fixed an issue with how the Leave in Advance amount on an employee's termination pay is calculated. The
last line of any leave taken but not entitled is not longer ignored in the accumulated amount. 

Amounts on the ETP Payment Summary report are now truncated and not rounded up. For example, an ETP amount
of 1226.76 now displays as $1226 in the report and not as $1227.  

We've fixed a problem in which automatically-generated pays display as changed, even though they weren't edited,
when you process pays. 

Inventory 

 

We've resolved Error 1090 on the Inventory Reorder Maintenance form. This error occurred when a user entered
a Min Qty and a Max Qty, then saved before moving out of the Max Qty field to enter a value in the Economical
Order field. 

We've fixed an issue in which the Kitset components not found error displays when you try to delete or change a
quantity or replace a kitset item on a Job Transfer transaction. 

When you drill down on the On-requisition item on the Inventory Item Maintenance form, the Requisition Entry form
opens with the Submitted, Confirmed, and Part Processed options selected. 

The requisition quantity is aligned with the calculation used when the Drill down on Requisition Quantity displayed on the
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Inventory Maintenance form. The Requisition Enquiry form now opens and defaults the search criteria to the statuses
of Submitted, Confirmed, and Part Processed. 

Loading location balances by lot number is now faster. 

JADE Utilities 

We've resolved these issues: 

An error on a browser form that caused the screen re-optimisation phase to stop and display the error CRM Product
Code and Description search field. 

A set of database errors that caused the upgrade process to crash. 

A small number of database errors that were introduced during the upgrade to version 2017.2.0. 

Job Cost 

Error 1090 Attempted Access via Null object no longer displays when you save and reload the JC Job Template form
after creating a template. 

Error 1309 - Object already added to this set or dictionary no longer occurs when you click Create Sales Invoice on
the JC AR Invoice Entry form. 

We've fixed an issue with the Plant Charges Entry form where a posting date was saved and then updated to a
different period, the general ledger's transaction date was not updating, and the general ledger's trial balance was out
of balance. 

Mobility 

 

We've resolved Error 193 on mobile devices that try to connect to Greentree. 

We've fixed a fault in generating a packing slip from a sales order, which prevented users from picking lot-controlled
kitset components. 

Reporting 

When you delete data in a Query report, clicking Cancel now stops the deletion process. If you try to delete data in
the Results table using a JADE query, Error 4 no longer displays. 

We've fixed a problem where Greentree entered a loop when reporting on an HRPersonSchedule with a schedule
type of Recurring and with the isCompleted option selected. 

Windows Designer 
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You can once again use Windows Designer to customise forms that VADs have subclassed. 

We've fixed a problem in which a user-defined field that was moved using Windows Designer appears in the
top-right corner of a form when you drill down to: 

A form from the Workflow Desktop or an alert collection, or 

A masterfile from a data entry form. 

We've fixed an issue where the Designer item was not available under the System > Customisation menu. 

Various Fixes 

The message An error has occurred (4), object not found no longer displays when you try to open the preferences
forms. 

Pressing F6 to move to the next tab on a form no longer displays the error message Exception 1011 requested
property not defined. 

We've fixed an issue where clicking Cancel when deleting data on a Query report did not stop the delete command
from executing. 

The error Break time cannot exceed work time no longer displays when setting up split shifts on the Working Calendar
Maintenance form. 

You can now export an Explorer report to XML without style errors. You can open the report in Microsoft Excel. 

Debt collection emails in HTML format now generate correctly. 

The Print and Task queue no longer crashes when you run a refresh index task. 

When you import a sales order into EDI, the sales order now uses the correct delivery address. 

Error 1090 - Attempted access via null object no longer displays when you try to purge sales orders using sales order
numbers or dates as criteria. 

When you copy a requisition on the Requisition Entry form, the Reqn. Date and Expected Date fields contain the date
on which you made the copy.

Reference:

Type: Bug

Release version: 2018.3.0

Browser Approvals

Greentree Browser - New Columns Added to the Browser Timesheet Review Form 
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We've added these columns to the Timesheet Review form in Greentree Browser: 

Job - The code and description of the job on the timesheet line. 

Activity - The code and description of the activity associated with the job. 

Work Centre - The code and description of the work centre associated with the job. 

 

The new columns add more detail to the form and make it easier for reviewers to check employee timesheets. Reviewers no
longer need to drill down into individual timesheets to check information at line level. 

 

Reference:

Type: Enhancement

Release version: 2018.3.0

Greentree Browser - Issues Fixed in 2018.3.0

We've fixed these issues in Greentree Browser: 

When entering lines for sales and service quotes or sales orders, the Unit Price remains unchanged when you click
between the Amount and Quantity fields. 

We've fixed a bug in which the Browser Designer module wasn't available to sites that are licensed for it. 

After you've changed the stage of a quote or added a tree or a user-defined field to a quote, you can now close the
quote form by clicking the Close icon. 

Error 1090 no longer displays when you submit a leave request when logged into Greentree Browser using Internet
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Explorer. 

We've fixed a bug that prevented users from closing a quote after changing the stage or adding an attribute (like a tree
or a user-defined field) to the quote.

Reference:

Type: Bug

Release version: 2018.3.0
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